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contained herein.
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

Federal law restricts this 
device to sale by or on 
the order of a physician.
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Program Intended Use
The Corridor Browser application provides an intuitive file management 
interface for data access and management. Users can receive, export, and 
query/retrieve DICOM part 10 image files through DICOM connectivity 
to network connected workstations. The Browser application provides 
DICOM file import and export capability to local and network directories. 
The Browser permits the user to filter, edit, and select the data to pass to an 
application (e.g. Corridor4DM).

Program Description
Corridor Browser is a comprehensive data access, transfer and file management system for medical 
imaging data.  Its simple and intuitive interface provides an environment where users can perform a 
variety of image file management operations such as store, import, receive, and transfer files between 
local, shared, and DICOM nodes and perform DICOM Query/Retrieve operations.

Finally, Corridor Browser provides a gateway to Corridor4DM — an advanced visualization, quantification, 
and reporting software solution by selecting Corridor4DM from the Browser’s application panel.

You can use the Corridor Browser application to do the following:

▪▪ Receive and store DICOM image files sent by remote DICOM nodes to a local or network 
connected database or directory.

▪▪ Receive Pegasys file formatted images stored to an SCP directory and convert them to an INVIA 
native DICOM image format.

▪▪ Receive ECAT file formatted images stored to an SCP directory and convert them to an INVIA 
native DICOM image format.

▪▪ Automatically import DICOM image files stored within a defined directory.

▪▪ Query/retrieve a list of DICOM image files from remote DICOM nodes to a local or network 
connected database, or a directory.

▪▪ Export DICOM image files to local or networked databases and/or directories.

▪▪ Export DICOM image files to a remote DICOM node supporting DICOM store.

▪▪ Export DICOM image files to external media (CD, DVD, and USB drive).

▪▪ Manage multiple databases and/or directories to organize patient data for review.

▪▪ Set a search filter for a database or directory to display data based on Patient, Study, and Series 
information in the DICOM file.

▪▪ Edit DICOM image files to correct user input errors.
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User’s Guide Conventions
Throughout this guide, INVIA will rely on consistent use of terminology and symbols to best communicate 
with you, the end user. Below is a summary of these conventions:

▪▪ Blue, underlined text represents links to help you quickly navigate within this document or 
launch online content (Internet access required).

▪▪ Helpful hints, warnings, and additional information, which appear in the left margin for quick 
and easy reference, are identified by various symbols: 

 Note ! Warning  Tip  Right Click 
Option

Common Abbreviations
The user’s manual and user interface will rely on the following abbreviations:

Abbreviation Description
AE Title Application Entity Title identifies the DICOM nodes communicating between 

each other.
DICOM Digital Imaging and Communications in Medicine (DICOM) is a standard for 

handling, storing, printing, and transmitting information in medical imaging.
IP Internet Protocol is a unique identification number, such as 127.0.0.1, for 

devices (computers, printers) within a network.
SCP Service Class Provider
SCU Service Class User

System Requirements

Supported Operating 
Systems:

Windows® 7 (32- and 64-bit)
Windows® 8 (32- and 64-bit)
Windows® Server 2008 R2
Windows® Server 2012 R2

Processor Speed: 2.0 GHz or greater
Memory: 3 GB recommended

Disk Space: 1 GB required for installation; 2-4 GB additional disk space for image files

Display:
1280x1024 or higher recommended
24 bit color

3D Graphics Card: 
256 MB or higher recommended
3D graphic card supporting OpenGL 3.0 is recommended

Networking: Networking  adapter card (ethernet or wifi) required

Installation of Corridor Browser
1.	 Close any previous versions of Corridor Browser and Corridor4DM that are open.

2.	 Insert the installation CD into your computer’s CD drive.

3.	 Click on Install Corridor4DM. 


More detailed 
instructions for product 
installation can be found 
on the Training and 
Support pages at  
www.inviasolutions.com

http://www.inviasolutions.com
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4.	 Follow the on-screen installation instructions.

5.	 To launch Corridor Browser, select Corridor4DM from the INVIA tab in your program list in 
the Start Menu.

Licensing
In order to run Corridor Browser, you must have a valid license key. The application supports both fixed 
and floating licenses.  To open the Corridor Browser Licensing window, open Corridor Browser and 
select Licensing from the Help menu. Users have the option to select the site-specific license model 
type.  The fields within the Corridor Browser Licensing window will change based upon selection.

Fixed License Model (Figure 1.1)

1.	 Hardware ID: This is a unique identifier 
specific to the workstation to which 4DM 
is licensed. 

1.	 File Location:  When licensing a fixed 
installation, the user can navigate to 
the directory folder where the 4DM 
fixed license key file is located.  Once 
Check Status 	 is selected, 4DM will 
automatically copy the license file to 
the 4DM application directory and 	
display the file path.

2.	 Status:  Displays any messages regarding 
the validation of the license key file.

3.	 Available Features:  Lists the features 
defined by the license key.

Floating License Model (Figure 1.2)

1.	 IP Address and Port:  User enters the IP 
Address and Port number for the license 
manager.  Select Check Status to verify 
connection to the license manager.

2.	 Server Information: Displays the active 
license manager address, total number of 
licenses on the license manager, and the 
number of licenses in use.  The Details 
button provides more information about 
the license manager.	

3.	 Status: Displays any messages regarding 
the validation of the license key file.

4.	 Available Features:  Lists the features 
defined by the license key.

	

Figure 1.1: The Corridor Browser Licensing window - Fixed 
License Model

Left-click About from 
the Help menu to review 
Corridor Browser 
product information, a 
summary of licensing 
information, and to 
access this User’s Guide.



The Corridor Browser 
Licensing window can 
also be accessed from the 
Windows Start Menu. 
Select INVIA and then 
INVIA Licensing.







Figure 1.2: The Corridor Browser Licensing window - 
Floating License Model










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This chapter guides users through Corridor Browser’s basic features and functionality while accessing 
patient files from local and shared directories.

Screen Overview
First, the user should become familiar with the application’s user interface (Figure 2.1 ). The menu bar at 
the top of the interface includes the File, Tools, and Help menus. The interface is designed to flow from 
left-to-right, with three areas: Sources, Search/Patient List, and Applications/Destinations.

▪▪ Sources – The left side of the Browser interface provides a list of data sources. Navigate 
local or shared directories within the Local tab and DICOM-connected workstations within 
the Remote tab to access patient datasets. Add local and DICOM folders and databases to 
the Sources panel for easy access. 

▪▪ Search/Patient List – The center area of the Browser interface allows users to 
filter imaging data by applying search parameters or by prioritizing according to file 
characteristics. Select one or multiple items from the patient list for review or transfer.

▪▪ Applications/Destinations – The right side of the Browser interface applies actions to 
patient files. Launch a patient file in Corridor4DM for review, or copy files to local or 
remote destinations.

	 Chapter 2	 Using Corridor Browser


For help retrieving files 
from remote DICOM 
nodes, go to Chapter 4: 
DICOM Configuration.

Sources Search / Patient List Applications/
Destinations

Figure 2.1: The Corridor Browser screen contains File, Tools, and Help menus, and three areas for user interactions: 
Sources, Search / Patient List, and Applications / Destinations
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Menu Bar

The top menu bar contains File, Tools and Help

File (Figure 2.2)

▪▪ Exit: Exits the Browser application

Tools (Figure 2.3)

▪▪ Database Manager: Described in Chapter 3

▪▪ Local SCP Configuration: Described in Chapter 4

▪▪ DICOM Node Configuration: Described in Chapter 4

▪▪ Job Queue Manager: Described in Chapter 2

▪▪ Preferences: Described in Chapter 5

▪▪ Auto Import: Described in Chapter 4

Help options (Figure 2.4)

▪▪ About: Provides Browser Product Information, Language 
Setting, License Information, Feature List and User 
Guide button 

▪▪ Licensing: Described in Chapter 1

▪▪ Event Viewer: Described in Chapter 4

▪▪ Watch Corridor Browser Log: Described in Chapter 4

Sources

The installation process creates a default database on your local drive and loads sample files to a folder on 
your system. These two locations appear as shortcuts in the top left panel of the application (Figure 2.5). 
To browse for local folders with stored DICOM files, simply navigate to the desired location using the 
folder structure directory in the bottom panel of the Local Sources tab (Figure 2.6).



You can load studies 
from multiple sources at 
the same time. Corridor 
Browser will load studies 
from each source that is 
selected.

Figure 2.2: File Menu

Figure 2.3: Tools Menu

Figure 2.4: Tools Menu

Figure 2.5: This area displays shortcuts to local folders. Figure 2.6: An example of the folder directory panel.



Corridor Browser ▪ User’s Guide	 Chapter 2: Using Corridor Browser ▪ 6

To Select Local Data Sources

▪▪ Click on the desired database or directory so it 
is selected (Figure 2.7). Click the Refresh tool 
(Figure 2.8) in the Patient List Panel to display a 
list of patient files.

To Create a New Source Directory

▪▪ Click the Add Local tool (Figure 2.9). Select the 
desired directory and click OK. The new Directory will 
appear in the top Local Sources panel.

To Navigate to a Local Directory (local or mapped drives)

▪▪ Navigate to the directory and folder of your choice. Click 
on the desired destination so it is highlighted blue. Click the Refresh tool in the Patient 
List Panel to display a list of patient files.

Search/Patient List

The center of the Corridor Browser interface provides the Search panel and Patient List panel.

Search Panel

The Search panel (Figure 2.10) can be used to search a large database for patient studies. The search 
criteria can be set by Patient Name, Patient ID, Modality, Study Date, Study Description or Series 
Description.

Enter the search qualifiers into the various text fields and then click the Refresh tool in the Patient List 
panel. For examples, see the Tip in the left-column.

The only field that is not text based is the Study Date. This field uses a drop-down menu to set the 
parameters for the search and a pop-up calendar for date selection (Figure 2.11):

▪▪ All Dates: Query does not restrict returned files according to dates.

▪▪ On: Query will return only studies performed on the specified date.

▪▪ Before: Query will return only studies performed before the specified date.

▪▪ After: Query will return only 
studies performed after the 
specified date.

▪▪ Between: Query will return 
only studies performed 
between the two specified 
dates.

Figure 2.7: Selected Local Source

Figure 2.8: Patient List Panel

Figure 2.9: Add Local tool in 
Local Sources Panel


Save time when loading 
studies — put your most 
frequently used databases 
and folders in the 
Sources menu.

Figure 2.10: The Search panel in its default state

Figure 2.11:  The Study Date area includes a drop-down 
menu of the various parameters for a Study Date search and 

drop-down menus for day, month, and year.



Search Parameters and 
use of the Wildcard (*): 

▪▪ abc – Returns items 
that exactly match 
“abc”

▪▪ abc* - Returns all 
items that match the 
characters before the 
asterisk (*); all other 
characters are ignored 
(e.g., abc, abcd, abcde, 
etc).

▪▪ *abc – Returns all 
items that match the 
characters after the 
asterisk (*); all other 
characters are ignored 
(e.g., mabc, nabc, 
oabc, etc). 

▪▪ *abc* – Returns all 
items that match the 
substring “abc” (e.g., 
abcd, dabc, fabcg, 
etc.)


Search parameters are 
not case sensitive. A 
search for ABC will 
return the same results as 
Abc or abc. 
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▪▪ Today: Query will return only studies performed that day.

▪▪ Yesterday: Query will return only studies performed on the previous day.

▪▪ Last 2 Days: Query will return all studies performed within the past two days.

▪▪ Last 7 Days: Query will return all studies performed within the past seven days.

Click the Reset tool  (Figure 2.12) to clear all fields.

Patient List Panel

The Patient List panel displays available files from the selected source(s) or source location(s) 
(Figure 2.13).

This area contains five User Control tools (Figure 2.14) and four File View tools 
(Figure 2.15): 

▪▪ Refresh (Double Arrows): Populates or updates the list with files from the 
selected source as filtered according to the search parameters.

▪▪ Stop Refresh (Double Arrows with Hand): Cancels the patient list update 
action initiated by the Refresh button.

▪▪ Select All (Cursor Arrow with a Check Mark): Selects all of the displayed 
patient files within the patient list.

▪▪ Unselect All  (Cursor Arrow with a Minus Sign): Deselects all of the 
displayed patient files within the patient list.

▪▪ Delete Selected Dataset(s) (Trash Can): Deletes the selected file(s) from 
the patient list and the source directory. 

▪▪ Patient (Person): Displays Patient Name, Patient ID, Most Recent Study 
Date, Number of Studies, and Location within the display list.

▪▪ Study (Scanner): Displays Patient Name, Patient ID, Study Date, Study 
Description, Modalities, Number of Series, and Location within the display 
list.

▪▪ Series (Single X-Ray): Displays Patient Name, Patient ID, Modality, 
Series Date, Series Description, Number of Images, and Location within 
the display list.

▪▪ Instance (Two X-Rays):  Displays Patient Name, Patient ID, Modality, 
Instance Date, Instance Description, and Location (only available within 
local mode).



Corridor Browser will 
conduct the following 
date-based searches 
according to your 
computer’s date setting:

▪▪ Today

▪▪ Yesterday

▪▪ Last 2 Days

▪▪ Last 7 Days



When a patient or 
multiple patients are 
selected, the Study, 
Series, and Instance 
Views will apply only to 
those selected patients.  
Return to the Patient 
View to see all available 
patients.


By default, the file list 
will be organized by the 
Patient Name column, 
starting with numerical 
file names and then 
alphabetic file names.

Figure 2.12:  
Reset tool

Figure 2.13:  Patient List

The end user has the 
ability to copy/paste the 
patient list into other 
applications such as 
MSWord, Notepad, Excel 
and other documents 
that support copy/paste 
of text.

Figure 2.14: User 
Control tools

Figure 2.15: File 
View tools
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By clicking on the column header in the Patient List panel, the list will sort according to that field. 
The sort order is designated with a small black triangle. A single click will organize the information in 
ascending order, and a second click will reverse the order. The columns can be resized by clicking-and-
dragging on the column border.

Applications/Destinations

The functionality to apply an action to patient files is located in Corridor Browser’s right panel. This panel 
is divided into two areas: the top half is the Applications panel providing button controls for launching 
additional applications; the bottom half is the Destinations panel providing file transfer capabilities.

Applications Panel

To open desired files within Corridor4DM for study review, the user simply needs to select the specific 
files (Figure 2.16), and then click the 4DM button in the Applications panel. In the example below, the 
user selected two patients for review.

DICOM Editor

The DICOM Editor (Figure 
2.18) is accessed through the 
Application Panel. The DICOM 
Editor can be used to view patient 
DICOM information, anonymize 
patient data, review entire DICOM 
attributes and edit DICOM 
attributes in the selected file.

To load a patient into the editor, 
select it from the Patient List and 
click the DICOM Editor button 
from the Applications panel. 



Select multiple files 
at once to save time. 
Hold the shift key while 
selecting the first and last 
in consecutive list. Hold 
the control key [Ctrl] 
while selecting multiple 
inconsecutive items.

Figure 2.16: Select files to open in the browser window

!
WARNING
Changing Patient Name, 
Patient ID, Birth Date, 
and Gender can affect 
diagnostic results.



Edit Command Line 
Arguments: 

Right-click on the 4DM 
application button to 
launch the editor (Figure 
2.17).  

The user can edit the 
command line to select a 
specific user workflow to 
always launch when the 
4DM application button 
is selected, e.g. -user 
DrSPECTReview.  

This command will 
launch 4DM with the 
user configured workflow 
until it is deleted from 
the Edit Command Line 
Arguments field.

Figure 2.18: DICOM Editor

Figure 2.17: Right-click to access the 
Command Line Window
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To Anonymize a Patient Name:

▪▪ Select Anonymize Patient Name (Figure 2.19)
–– When the button is activated it will 
clear the First Name, Middle Name, 
Last Name, Prefix and Suffix fields.  
The Last Name field will display 
ANON followed by the first three 
characters of last name and the first 
character of first name. (i.e., John 
Doe becomes ANONDOEJ)

To Anonymize a Patient ID:

▪▪ Select Anonymize Patient ID (Figure 2.20)
–– When the button is activated it will 
clear the ID Number field and then 
display ANON followed by first 
four digits of ID Number followed 
by date and time on system at 
time of edit. (i.e., ID NUMBER 
is 12345678  edit occurred on 
9/8/2009 at 12:12:12pm, becomes 
ANON123420090809121212)

To Review DICOM file:

▪▪ Select Review Entire File (Figure 
2.21)

▪▪ A text file will open in Notepad listing 
the DICOM attributes for the selected 
dataset

▪▪ Displayed fields are not editable

To Edit DICOM information in a selected file:

▪▪ Choose a field you want to edit 

–– Editable fields are indicated by a text box and allows free text editing

▪▪ Click Save to overwrite the original file passed to the editor or Cancel to exit without edits

To Generate New Patient from a selected file:

▪▪ Edit the Patient Name or Patient ID 

–– The New Patient button is now available

▪▪ Click New Patient to generate the newly defined patient with a copy of all other DICOM 
fields loaded into the editor



The check box 
for Anonymize 
Miscellaneous 
Information is 
deselected by default. 
If selected, it will 
anonymize multiple 
miscellaneous DICOM 
fields including: 
Institution Name, 
Institution Address, 
Referring Physician 
Name, Patient Insurance 
Code, and more.


If the patient is located 
in a Database the 
Overwrite option is 
disabled. 

Figure 2.19: DICOM Editor - Anonymize Patient Name

Figure 2.20: DICOM Editor - Anonymize Patient ID

Figure 2.21: DICOM Editor - Review Entire File
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Destinations Panel (Figure 2.22)

To copy patients to a database:

▪▪ Select specific patient files
▪▪ Select the target database
▪▪ Click the Copy To tool (Figure 2.23)

To copy patients to a DICOM node:

▪▪ Select specific patient files
▪▪ Select the target DICOM node
▪▪ Click once on Copy To tool

To copy patients to a New Directory:

▪▪ First, create a new directory
–– Click the Add Local (Figure 2.24) button
–– Select the desired directory
–– Select OK

▪▪ The new directory path will appear in the Destinations panel
–– Select specific patient files
–– Select the target directory

▪▪ Click once on Copy To tool

Status Bar
The Corridor Browser interface provides a Status Bar along the bottom of the Browser Screen. There are 
five display panels on the Status Bar (Figure 2.25): 

▪▪ Job Queue: The number of Active Jobs and Completed Jobs will be displayed in addition 
to Last Job Status.  If an error occurs, the Failed status window will be displayed and 
provide the reason of failure.  
–– Left-click on the Job Queue to view the Job Queue Manager.

▪▪ Job Queue Manager:  Displays Status, Timestamp, Type and Details for both Active Jobs 
and Completed Jobs.
–– Active Jobs: The user can View Job Details, Move Job Up,  Move Job Down, Cancel Job 
and Pause/Resume Job in the Job Queue Manager.

–– Completed Jobs: The user can View Job Details and Delete/Clear All jobs in the Job Queue 
Manager.

▪▪ Action Status: Displays Copying actions. 

▪▪ Number of Pending Results: Denotes the number of DICOM result files from Corridor4DM 
pending import into a database.

▪▪ Number of Patients: The number displayed depends on the Patient Display List
–– Displays the total number of selected patient files.

Figure 2.22: Destination Panel

Figure 2.23: Copy To 
tool

Figure 2.24: Add 
Local tool


Right-click on the status 
bar to display the last 100 
actions in a window.

Figure 2.25: Corridor Browser Status Bar



Corridor Browser ▪ User’s Guide	 Chapter 2: Using Corridor Browser ▪ 11

▪▪ Number of Studies: The number displayed depends on the Patient Display List
–– Displays the total number of selected study files

▪▪ Number of Series: The number displayed depends on the Patient Display List
–– Displays the total number of selected series files

▪▪ Number of Instances: The number displayed depends on the Patient Display List
–– Displays the total number of selected instance files. (Only available on the Local tab. On the 
Remote Tab, the display panel is always blank.)
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Database Manager
The Database Manager window (Figure 3.1) is accessible from the Tools menu and permits the user to 
add and delete databases as well as manage database files.

These are the Database Manager tools:

▪▪ Database Information: (Figure 3.2) Provides details about the 
selected database (Database ID, Database Filename, Database 
Location and Type (local or network).  Left-click to access the 
following database tools (Figure 3.3):

–– Test Database Connectivity: Tests the connectivity between Corridor 
Browser and the selected database. This is useful for troubleshooting 
issues with networked databases. 

–– Database Cleanup Schedule: This tool provides a window where the 
user can define an automatic cleanup schedule to reduce the size of an 
image database.  Within this window, the user can define the time the 
scheduled cleanup will occur and the criteria for what files are to be 
deleted when threshold limits are reached.

–– Rebuild Database Index: Reconciles the number of database entries 
with the number of files.

–– Compact Databases: Reclaims wasted space within the databases and 
improves performance. 

–– Database Auto-Routing Schedule: This tool provides a window 
where the user can specify a DICOM destination where images will be 
automatically transferred.  This is primarily used for pushing results to 
a PACS system.  For each database, the user can specify one or more 
destination DICOM nodes (Auto-Routing Nodes), a start date after 
which all image files will automatically transfer to the destination(s), 
and the schedule time when the automatic transfer will occur. 

	 Chapter 3	 Database Management









Figure 3.1: Creating a new data storage location using the Database Manager

Figure 3.2: 
Database 

Information Tool



If All Studies Older Than 
a certain number of days 
is selected, comparison 
studies that are older 
than the defined day 
range in the database will 
be deleted during the 
Database Cleanup Time.



Databases have an 
advantage over folders 
when it comes to patient 
file storage. Queries 
return search results in 
less time. Also, users can 
efficiently add and delete 
files.

Figure 3.3: 
Database 

Information Window 
Tools












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▪▪ Add/Link Database: (Figure 3.4) Creates or links a database and adds it to the Sources and 
Destination panels. 

▪▪ Rename Database: (Figure 3.5) Edit the selected database name.

▪▪ Unlink Database: (Figure 3.6) Unlink the selected database from the system and remove it 
from the lists in the Sources panel and Destinations panel without deleting all related data 
from the system.

▪▪ Delete Database: (Figure 3.7) Deletes the database from the database list in the Sources 
panel, Destinations panel, and all related data from the system. This operation cannot be 
reversed.

▪▪ Refresh: (Figure 3.8) Updates the current list of the database tables.

Creating a Local Database for Image Storage

Users can build multiple databases to catalog patient 
data for specific uses. As an example, this guide will 
illustrate creating a Training database.

1.	 Open the Database Manager window from 
the Tools menu

2.	 Select Add/Link Database tool

3.	 Create a new File name (see  Figure 3.9)
4.	 Files type will remain INVIA Database 

(*.icbd)
5.	 Select Open to complete the task
6.	 The new database name will appear 

automatically in the Database Manager 

Creating a Network Database for Image Storage

Prior to creating a network database, you will need to insure that the directory on the remote computer 
is shared to the network. You also need to insure that the security settings for this directory allows for 
remote users to read and write files to this directory. Once sharing and security are defined on the remote 
computer:

1.	 Open the Database Manager window from the Tools menu
2.	 Select Add/Link Database
3.	 Navigate to the shared directory
4.	 Create a new File name (e.g. Training)
5.	 Files type will remain INVIA Database (*.icbd)
6.	 Select Open to complete the task
7.	 The new database name will appear automatically in the Database Manager 



Want to collect 
interesting cases in a 
single database? Create 
a custom database and 
copy patient files using 
the Corridor Browser file 
transfer functionality. 

Figure 3.4: Add/
Link Database 

Tool

Figure 3.5: Rename 
Database Tool

Figure 3.6: Unlink 
Database Tool

Figure 3.7: Delete 
Database Tool

Figure 3.8: Refresh 
Tool

Figure 3.9: Creating a new database in Corridor Browser


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Upon installation, Corridor Browser will configure a base Service Class Provider (SCP) using the 
following parameters:

1.	 Station Name (by default, this will be the computer’s name)
2.	 Application Entity (AE) Title (same as Station Name by default)
3.	 Port # (automatically generated with first available port starting with Port 104)
4.	 IP address or addresses
5.	 Data Storage (“Database: Default” is assigned upon installation)

Local SCP Configuration

Base SCP Configuration

Initiating the Base SCP

Once Corridor Browser is installed, users 
must turn on the Base SCP so Corridor 
Browser can “listen” for other DICOM 
workstations. 

1.	 Launch Corridor Browser
2.	 Select Local SCP Configuration 

from the Tools menu at the top of 
the Corridor Browser interface

3.	 In the Local SCP Configuration 
(Figure 4.1) window, verify that 
the SCP status is on and click OK

All SCPs need the type of file storage defined 
(e.g., database or files). The base SCP will 
store transferred files to the default database 
created at installation. 

Customizing the Base SCP Configuration

▪▪ In the Local SCP Configuration window, customize the following fields in the Base SCP 
Configuration panel (Figure 4.2):
–– Station Name
–– AE Title
–– Port 
–– IP

	 Chapter 4	 DICOM Configuration

Figure 4.1: The Local SCP Configuration window 



SCP vs. SCU
These two terms 
are important for 
understanding the 
communication 
capabilities of DICOM 
compliant workstations.

A Service Class User 
(SCU) is a device that 
requests a DICOM 
Service, typically a client 
requesting information or 
data from an SCP.

A Service Class Provider 
(SCP) is the device that 
provides the service to an 
SCU, e.g. image storage, 
image query with image 
storage. 

Corridor Browser 
provides connectivity for 
both of these services. 
Databases or folders 
saved in the Sources 
panel act as SCUs while 
databases or folders 
saved in the Destinations 
panel act as SCPs.

Figure 4.2: The SCP Base Configuration area is the top panel 
within the Local SCP Configuration window



When defining a port, 
users should confirm that 
the port is not used by 
another network service. 
Consult your IT manager 
for assistance.



The Station Name will
identify the Corridor
Browser-based SCP
within the network.
This SCP will initially
listen on all available
IP addresses. If no IP
address is available,
None will appear as the
IP address and the SCP
service will remain off
until an IP address is
available or defined.
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Assigning a Database to the Base SCP

▪▪ In the Local SCP Configuration window, select the Data Storage 
drop-down menu

▪▪ Select Database (Figure 4.3)
▪▪ Select the desired database in the second drop-down menu 

–– If the default database is the only available option, you can 
reference Chapter 3 to create a new database

Assigning File Location to the Base SCP

▪▪ In the Local SCP Configuration window, select the Data Storage drop down menu in the 
Base SCP Configuration panel (top):

▪▪ Select Files
▪▪ The following fields are now available for edit:

–– Root Directory (Browse): Main location of the directory
–– 1st Subdirectory: First level of the directory organization
–– 2nd Subdirectory: Second level of the directory organization (Figure 4.4)

Additional Local SCPs

Creating Additional Local SCPs

▪▪ In the Local SCP Configuration window, make the following edits in the Additional Local 
SCPs panel (Figure 4.5):
–– Enter a unique AE Title and Port #
–– Set the Data Storage location 
–– Turn SCP Status On
–– Click the Add tool (Figure 4.6)



Any changes to the Base 
SCP and Additional 
Local SCPs will cause it 
to automatically stop and 
restart. This is a “behind 
the scenes” action and 
generally takes less than 
30 seconds. Any changes 
to an SCP should not 
occur during data 
transfers.



When defining a port, 
users should confirm that 
the port is not used by 
another network service. 
Consult your IT manager 
for assistance.



Users can organize files 
within the SCP root 
folder by selecting a first 
and second subdirectory. 
Data can be arranged by:

▪▪ Patient Name
▪▪ Patient ID
▪▪ Modality
▪▪ Study Date
▪▪ None

Figure 4.3: Database 
selection options

Figure 4.4: Example of the file directory structure

Figure 4.5: The Additional Local SCP area is the bottom panel within 
the Local SCP Configuration window.

 Figure 4.6: 
Add Tool
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Assigning a Database to an Additional SCP

▪▪ In the Local SCP Configuration window, make the following edits in the Additional Local 
SCPs panel:
–– For a new SCP, enter AE Title, Port and Turn on SCP Status (reference Creating 
Additional Local SCP’s section above), then continue to next step

–– For an existing SCP, select the SCP in the list and continue to next step
▪▪ Go to the Data Storage drop down menu
▪▪ Select Database
▪▪ Select desired database in the second drop down menu 

–– If the default database is the only available option, you can reference 
Chapter 3 to create a new database

▪▪ For a new SCP, click the Add tool (Figure 4.7) and then click OK
▪▪ For an existing SCP, click the Edit tool (Figure 4.8) and then click OK

Assigning File Location to an Additional SCP

▪▪ Launch Corridor Browser
▪▪ Select Local SCP Configuration from the Tools menu
▪▪ In the Local SCP Configuration window, make the following edits in the Additional Local 

SCPs panel (bottom):
–– For a new SCP, enter AE Title, Port and Turn on SCP Status (reference Creating 
Additional Local SCP’s section above), then continue to next step

–– For an existing SCP, select the SCP in the list and continue to next step
▪▪ Go to the Data Storage drop down menu
▪▪ Select Files
▪▪ A new window will open to set the following fields 
▪▪ The following fields are now available for edit:

–– Root Directory (Browse): Main location of the directory
–– 1st Subdirectory: 1st level of the directory organization
–– 2nd Subdirectory: 2nd level of the directory organization (Figure 4.9)

▪▪ For a new SCP, click Add Local SCP and then click OK
▪▪ For an existing SCP, click Edit Local SCP and then click OK

SCP Services

Change the Base SCP Status 

▪▪ Set the SCP Status toggle (On or Off) (Figure 4.10)
▪▪ Click OK

 Figure 4.7: 
Add Tool

 Figure 4.8: 
Edit Tool

Figure 4.9: Example of the file directory structure

Figure 4.10: The SCP Status Toggle



When the SCP status 
is turned Off, remote 
DICOM work stations 
will not be able to 
transfer files to Corridor 
Browser.
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Change an Additional SCP Status 

1.	 Select the Additional SCP to be modified
2.	 Set the SCP Status Toggle (On or Off)
3.	 Click the Edit tool
4.	 Click OK

Deleting an SCP

To permanently remove a custom SCP, select it from the Additional Local 
SCP list, click the Delete (Figure 4.11) tool and then click OK to close the 
window.

Register SCP Service

For systems using the Windows Firewall (recommended), this button will register the CorridorSCP 
application with the firewall. By doing so, Browser allows outside computers to query and store images 
to the local SCP.

DICOM Nodes

DICOM Node Configuration

Adding a DICOM Workstation to the Sources and/or Destination Lists 

▪▪ Select DICOM Node Configuration 
from the Tools menu

▪▪ In the DICOM Node Configuration 
window (Figure 4.12), click the New 
tool (Figure 4.13) 

▪▪ Enter a unique Name in the DICOM 
Node Settings window (Figure 4.14)

▪▪ Enter the AE Title for the DICOM 
workstation to which you want to 
connect

▪▪ Confirm that the DICOM Port on the 
remote workstation is 104 (change it if necessary)

▪▪ Enter the DICOM workstation’s IP Address

▪▪ Select the desired Type for the DICOM Node
–– Query: Adds the new DICOM Node to the 
Sources panel on the Remote tab

–– Store: Adds the new DICOM Node to the 
Destinations panel on the Local and Remote tabs

▪▪ Click Test to confirm the DICOM connection is 
successful

▪▪ Click OK to close the Test window
▪▪ If passed, click OK on the DICOM Node Settings 

and DICOM Node Configuration windows to save 
settings



The Name field identifies 
the remote DICOM 
node within Corridor 
Browser. Use a unique 
name associated with 
that system (e.g. Camera 
Room One).

!

WARNING
Remote DICOM 
workstations will need 
to be configured to 
recognize Corridor 
Browser SCPs. Refer to 
the workstation user’s 
manual or contact a 
service representative for 
assistance.

Information necessary 
to complete this step 
includes AE Title, Port #, 
and IP address for each 
workstation.

For more information 
on remote workstation 
configuration, visit 
www.inviasolutions.com


Users cannot delete the 
Base SCP; it can only be 
deactivated (turned off).

 Figure 4.11: 
Delete Tool

Figure 4.12: DICOM Node Configuration window

Figure 4.13: 
New Tool

Figure 4.14: DICOM Node Settings

http://www.inviasolutions.com
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Editing a Previously Added DICOM Node 

▪▪ Click the desired DICOM node from the DICOM Node Configuration window (Figure 4.15)
▪▪ Click the Edit tool.
▪▪ Make the necessary changes on the 

DICOM Node Settings window
▪▪ Click the Test tool to confirm the 

DICOM connection is successful
▪▪ Click OK to close the Test window
▪▪ If passed, click OK on the DICOM 

Node Settings and DICOM Node 
Configuration windows to save 
settings

Deleting a Previously Added DICOM Node

▪▪ Select DICOM Node Configuration from the Tools menu
▪▪ Click the desired DICOM node

▪▪ Click the Delete tool then OK to close the window

Auto Import Configuration
The Corridor Browser will enable the user to import a specific image file type (i.e. DICOM, 
Pegasys, ECAT) from a Windows directory folder automatically into the local DICOM SCP data 
storage location.  The files are deleted from the Windows directory folder after the transfer has 
completed.

How to Configure

1.	 Select Auto Import from the Tools menu found on the top Menu Bar.

2.	 Click Browse to navigate and select the Windows directory folder.

3.	 Select the Data Format for incoming image file types.

▪▪ DICOM – If selected, only DICOM files are read and pushed to the SCP.

▪▪ Pegasys – This selection will only read and convert Pegasys formatted image files.  
If selected prior to sending to the SCP, the files are converted from Pegasys format to 
INVIA DICOM format.

▪▪ ECAT – This selection will only read and convert ECAT 7 formatted image files.  If 
selected prior to sending to the SCP, the files are converted from ECAT format to 
INVIA DICOM format.

4.	 Select the Data Destination then Add.

The user can remove a Windows directory folder from the Auto Import directory list by clicking 
Delete.

Troubleshooting Auto-Import

During the conversion process, a “Pending” folder will be generated within the Auto Import specified 
directory folder as a temporary placeholder for files awaiting conversion.

Figure 4.15: Create, edit, delete, and test DICOM Nodes
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If the conversion process fails, then a “Failed” folder will be created within the Auto Import specified 
directory folder containing the files that failed the conversion process.

 If the user is trying to configure an auto import rule and there are not any options displayed in the data 
destination drop down menu, the user will need to turn “on” the Local Base SCP Configuration. 

Troubleshooting
Within the Corridor Browser Help menu, users can review a record of DICOM activity. The following 
logs are available:

▪▪ Event Viewer: Records all events and actions for all instances of Corridor Browser that are 
running. This information is used to track potential errors in the operation of the application 
which is useful for INVIA to troubleshoot problems with the application.

–– Select Event Viewer from the Help menu 
–– Once the Event Viewer is open, select INVIA from the list to view log entries
–– To save the INVIA log to aide in advanced troubleshooting
•	 Right-click on INVIA
•	 Select Save Log File As…

▪▪ Watch Corridor Browser: Provides a real time display of all actions and events executed 
by the currently active Corridor Browser application. When a problem has occurred with 
the application, this tool can help record the specific steps. This tool will be used by INVIA 
to troubleshoot problems with the Corridor Browser application.



Only one file type can be 
configured per directory.  

Different image file 
formats need to be sent to 
separate Windows 
directory folders.
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File Management
Corridor Browser is designed to provide an interface for DICOM file management. This section will
provide examples of file retrieval and transfer from a variety of sources.

Local to Local

Follow this tutorial to transfer DICOM files from local sources (folders or databases) to local destina-
tions (folders or databases). Refer to Chapter 2 for help creating local sources and destinations.

1.	 Within the Local tab, click the desired Source so it is selected (e.g., C:\Users\Public\Docu-

ments\INVIA\Corridor4DM\SampleData)

2.	 Click the Refresh tool in the Patient List Panel to display a list of patient files

3.	 Select files for transfer

4.	 Click the desired Local Destination so it is selected

5.	 Select the Copy To tool

6.	 Reference the Job Queue Manager in the Status Bar to confirm data transfer is complete
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b
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





←

←

←



←
← ←

←

←



Local to DICOM (Remote)

Follow this tutorial to transfer DICOM files from local sources to remote destinations. Refer 
to Chapter 2 for help creating local sources and Chapter 4 for help creating remote DICOM 
workstations.

1.	 Within the Local tab, click the desired Source so it is selected (e.g., C:\Users\Public\
Documents\INVIA\Corridor4DM\SampleData)

2.	 Click the Refresh tool in the Patient List Panel to display a list of patient files

3.	 Select files for transfer

4.	 Click the desired DICOM (Remote) Destination so it is selected

5.	 Select the Copy To tool

6.	 Reference the Job Queue Manager in the Status Bar to confirm data transfer is complete
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Figure 5.2: Local to DICOM (Remote) Data Transfers
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DICOM (Remote) to Local

Follow this tutorial to transfer DICOM files from remote sources to your PC. Refer to Chapter 4 for 
help creating Remote DICOM sources and destinations and Chapter 3 for help creating additional 
Local sources and destinations.

1.	 Click the Remote tab

2.	 Select the desired DICOM Source (e.g., DICOM: InterestingCases)

3.	 Once the data source is selected, click the Refresh tool in the Patient List Panel to display a 
list of patient files

4.	 Select files for transfer

5.	 Select the DICOM Destination labeled with your AE Title (e.g., DICOM:ReadingRoom). 
This will send the data to the location defined in the Local SCP Configuration

6.	 Select the Copy To tool

7.	 Reference the Job Queue Manager in the Status Bar to confirm data transfer is complete
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

In order to transfer
data from a remote
workstation to your PC,
you’ll need to start the
default SCP service.
Refer to Chapter 4 for
step-by-step instructions.


During installation,
Corridor Browser
names the Base SCP
with the same name
already assigned to your
computer.

Figure 5.3: DICOM (Remote) to Local Data Transfers
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DICOM (Remote) to DICOM (Remote)

Follow this tutorial to transfer DICOM files from remote DICOM sources to another remote 
DICOM destinations. Refer to Chapter 4 for help creating remote DICOM sources and 
workstations.

1.	 Click the Remote tab

2.	 Select the desired DICOM Source (e.g., DICOM: InterestingCases)

3.	 Once the data source is selected, click the Refresh tool in the Patient List Panel to display 
a list of patient files

4.	 Select files for transfer

5.	 Select the DICOM Destination (e.g., DICOM:Clinic).

6.	 Select the Copy To tool

7.	 Reference the Job Queue Manager in the Status Bar to confirm data transfer is complete

Figure 5.4: DICOM (Remote) to DICOM (Remote) Data Transfers
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Preferences
Corridor Browser provides the ability to Backup, 
Restore, and configure Options within Preferences. 
To access these settings, click Tools and select 
Preferences (Figure 5.5) to open the Corridor 
Browser Preferences window.

Backup

The Backup tab (Figure 5.6) enables the user 
to define a Backup Directory location and 
specify which options to select under Backup 
Global Settings/Directories and the Backup 
Format when performing a Corridor Browser 
Preference Backup.  This should be performed 
after the initial setup of Corridor Browser.

Restore

The Restore tab (Figure 5.7) enables the user 
to specify the directory location of the Corridor 
Browser Preference Backup using the Restore 
Directory.  Under Restore Global Settings/
Directories, the user selects from available 
options contained in the Corridor Browser 
Preference Backup to restore Corridor Browser 
settings.

Options

The Options tab (Figure 5.8) provides settings 
for Audit Logging to track user activity 
within Corridor Browser, Language Setting 
if the user wants to set a language used in 
Corridor4DM different from the Windows OS, 
and DICOMDIR support for exporting datasets 
with a DICOMDIR included.

Figure 5.5: Select Preferences

Figure 5.6: Browser Preferences - Backup

Figure 5.7: Browser Preferences - Restore

Figure 5.8: Browser Preferences - Options
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